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Kako   započeti

K ako radi interaktivna  ploča SMART Board?

Interaktivnu ploču SMART Board™ vrlo je jednostavno koristiti. Ako znate koristiti računalo, znat ćete koristiti i interaktivnu ploču SMART Board.
Zaslon osjetljiv na dodir spaja se s vašim računalom i projektorom kako bi se prikazala slika s vašeg računala. Aplikacijama na zaslonu možete upravljati prstom, pisati bilješke digitalnom tintom te spremiti svoj rad kako biste ga poslije mogli podijeliti s drugima.
Kako radi interaktivna ploča SMART Board?

Interaktivna ploča SMART Board osjetljiva je na dodir i funkcionira kao dio sustava koji uključuje računalo i projektor:
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•  Računalo šalje sliku aplikacije na projektor.
•  Projektor projicira sliku na interaktivnu ploču.
•  Interaktivna ploča ponaša se i kao zaslon i kao ulazni uređaj, omogućavajući vam kontrolu nad aplikacijom jednostavnim doticanjem interaktivne ploče.
Kako biste lakše shvatili koncept, promatrajte interaktivnu ploču na isti način kao i svog miša ili tipkovnicu – radi se o ulaznom uređaju koji vam omogućava upravljanje aplikacijama koje se nalaze na vašem računalu.
Vaš prst je vaš miš

Aplikacijama na svom računalu možete upravljati na interaktivnoj ploči. Pritisak prsta na interaktivnu ploču SMART Board istovjetan je kliku miša. Aplikacije se otvaraju na isti način kao i na stolnom računalu, ali umjesto da koristite miša za otvaranje datoteka, jednostavno pritisnite ili dvaput pritisnite ikonu koristeći svoj prst.
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Orijentacijom interaktivne ploče osigurat ćete usklađenost pokazivača miša s pritiskom svog prsta. Orijentacija je detaljno objašnjena na petoj stranici.
Držač za olovke SMART Pen

Držač za olovke SMART Pen sastoji se od četiri obojena utora za olovke i jednog utora za brisač. Svaki utor ima optički senzor koji pokazuje kada su olovke i brisač izvađeni. Sve dok je utor za olovku prazan, možete koristiti tu olovku ili svoj prst za pisanje. Tehnologija u držaču dovoljno je pametna da zna koji je pribor posljednji izvađen iz svoga utora. Ako izvadite brisač iz njegova utora dok istovremeno držite olovku, držač za olovke pretpostavit će da želite brisati. Svjetla iznad utora pokazuju koji je pribor izvađen posljednji.
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Gumbi na držaču za olovke
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Držač za olovke ima najmanje dva gumba. Jedan se gumb koristi za pokretanje virtualne tipkovnice na zaslonu. Drugi se gumb koristi kako bi sljedeći dodir na interaktivnoj ploči bio protumačen kao desni klik miša. Neke interaktivne ploče imaju i treći gumb; ovaj se gumb koristi za brz pristup centru za pomoć.
Gumbi na držaču za olovke

Gumbi na držaču za olovke

Olovke
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Interaktivna ploča SMART Board dolazi s četiri tzv. Whisper–tip™ olovke (crna, crvena, zelena i plava) te jednim brisačem. Iako nije potrebno koristiti olovke za pisanje po interaktivnoj ploči, one čine pisanje intuitivnijim. Uzmite olovku iz držača za olovke i počnite pisati. Kako biste obrisali digitalnu tintu, uzmite brisač iz držača za olovke, te prijeđite laganim pokretnom preko svojih bilješki. Bilješke će tada nestati.

Virtualna tipkovnica na zaslonu

Tipkajte ili uređujte tekst u bilo kojoj aplikaciji ne udaljujući se od interaktivne ploče.
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Pritisnite gumb Keyboard na držaču za olovke kako biste pokrenuli virtualnu tipkovnicu na zaslonu.
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	Izbornik tipkovnice: 
omogućava vam da izaberete koju tipkovnicu želite koristiti. Klasična (Classic) izgleda kao obična računalna tipkovnica. Brojčana tipkovnica (Number pad)  prikazuje brojeve, Pišite (Write) prepoznaje pisani rukopis. Prečac (Shortcut) omogućuje prepoznavanje pojedinog slova te daje kontrolne tipke tipkovnice i miša. Jednostavna tipkovnica (Simple) i Jednostavna velika slova (Simple Caps) složeni su  abecednim redom, što je dobra pomoć kada se radi s mlađim učenicima. 
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	Gumb sa strelicom 

Pritisnite gumb sa strelicom kako biste uključili okvir za pregled teksta. Kada je okvir za pregled teksta uključen, možete otipkati cijelu riječ ili rečenicu prije nego što pošaljete bilo kakvu informaciju prema aplikaciji. Kada ste gotovi s tipkanjem, pritiskom na gumb Send poslat ćete svoj tekst u aplikaciju koja je trenutačno aktivna.
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Virtualna tipkovnica na zaslonu s uključenim okvirom za pregled teksta
Desni  gumb miša

Pritisnite gumb Right Mouse na držaču za olovke kako bi vaš sljedeći pritisak na zaslonu bio prepoznat kao desni klik miša.
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Crtež u donjem desnom kutu vašeg zaslona pojavljuje se kako bi vas podsjetio da će sljedeći pritisak biti prepoznat kao desni klik miša.
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SAVJET: Umjesto korištenja gumba Right Mouse, pritisnite prstom i držite ga na dijelu zaslona gdje biste htjeli napraviti desni klik mišem. Nakon nekoliko sekundi pritiska na željenom području, pojavljuje se izbornik koji se inače pojavljuje prilikom desnog klika mišem.
Usmjeravanje interaktivne ploče SMART Board
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Usmjeravanjem se osigurava ispravno tumačenje vašeg dodira pri korištenju interaktivne ploče.
Ako dodirujete ikonu, a vaš se pokazivač čini kao da je na drugom mjestu od onoga koje pritišćete, pokušajte usmjeriti interaktivnu ploču. Nakon usmjeravanja, vaš pokazivač bi se trebao pojavljivati točno na mjestu gdje dodirujete interaktivnu ploču.
Kako biste pokrenuli funkciju usmjeravanja, istovremeno pritisnite i držite gumbe Keyboard i Right Mouse sve dok se na zaslonu ne pojavi orijentacijski prikaz.
Orijentacijski prikaz
Gumb  za pomoć 
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Ako držač za olovke ima gumb za pomoć, pritisnite ga kako biste pokrenuli dijaloški okvir za pomoć i podršku za svoju interaktivnu ploču SMART Board. Dijaloški okvir omogućava trenutačni pristup informacijama koje će vam pomoći  pronaći odgovor na gotovo bilo koje pitanje u vezi s vašim SMART proizvodom.

	[image: image7.jpg]Poravnaite/usmierite

SMART Board

Centar za pomo¢

Tehnitka podrika




	[image: image8.png]Alian/Orient the
SMART Board

Help Center

Technical Support







Svjetlosni indikator spremnosti

Vaša interaktivna ploča SMART Board uključuje svjetlosni indikator spremnosti koji upozorava na status vaše interaktivne ploče.
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	Boja svjetlosnog indikatora
	Status

	Nije upaljeno
	Interaktivna ploča nema napajanja. Provjerite spojene USB kabele.

	Trajno zeleno
	Interaktivna ploča uspješno komunicira sa SMART Board softverom na računalu.

	Treperi zeleno
	Interaktivna ploča SMART Board uspješno komunicira s upravljačkim datotekama za USB komunikaciju s računalom.
NAPOMENA: U ovom stanju, interaktivna ploča funkcionira jedino kao zaslon osjetljiv na dodir. Za potpunu funkcionalnost, pobrinite se da  SMART Board softver bude instaliran na vašem računalu.

	Trajno crveno
	Interaktivna ploča ima napajanje, ali ne komunicira s računalom. Tijekom početnog paljenja ili resetiranja napajanja, uočit ćete da se svjetlosni indikator na trenutak zacrveni. Ovo kratkotrajno crveno osvjetljenje normalna je pojava.

	Treperi žuto
	Događa se isključivo onda kada nadograđujete osnovni operativni program koristeći SMART Firmware Flashing Wizard. Ovo je normalna pojava.

	Trajno žuto
	Stanje problema. Pokušajte resetirati interaktivnu ploču isključujući i potom ponovno spajajući USB kabel na spoju s interaktivnom pločom.


Pisanje bilješki

Načinite bilješke ili crteže uklanjajući olovku iz držača za olovke i koristeći je za pisanje po površini interaktivne ploče.
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Tintni sloj
Kada izvadite olovku iz držača za olovke, oko vaše radne površine pojavljuje se okvir. Okvir upozorava na to da  je aktiviran prozirni sloj te možete pisati po radnoj površini kao što biste pisali po prozirnoj foliji. Prozirni sloj i njegov vidljivi okvir ostaju na mjestu sve dok sve olovke i brisač tinte ne vratite u držač za olovke i dok ne dotaknete ploču. Vašim prvim dodirom ploče, nakon što ste vratili sav pribor iz držača za olovke, pojavit će se izbornik.
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Primjer: prozirni sloj


Okvir
[image: image139.png]Microsoft Internet Explorer

Fle Edt View Favortes Took Help

Qux-© X[

address €] htpsffwnmy.goagle.com




[image: image140.png]



Izbornik tintnog sloja
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	Kada vratite olovku na mjesto u držaču za olovke i dodirnete interaktivnu ploču, uključit će se izbornik kao na slici. Pri tome možete odabrati spremanje svojih zabilješki snimanjem ili zatvaranje okvira uz brisanje zabilješki. Preko postavki možete predefinirati aktivnosti koje se događaju zatvaranjem tintnog sloja.
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Spremanje bilješki i crteža

Alatna traka Plutajući alati / Floating Tools automatski se pokreće kada podignete olovku iz držača za olovke. Možete koristiti gumb Snimanje zaslona / Area Capture kako biste spremili svoje bilješke i crteže.
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Gumb Snimanje zaslona / Area Capture (za spremanje dijela radne površine))
Kako biste spremili dio radne površine, slijedite ove upute:
1  Pritisnite gumb Snimanje zaslona (Area Capture) na alatnoj traci. Pojavljuje se alat za spremanje dijela radne površine.
2  Pritisnite na bilo koji kut područja koje želite spremiti te, zadržavajući pritisak, povucite selekcijski okvir sve dok ne okružite cjelokupnu željenu površinu.
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3  Popustite pritisak i vaš će odabir biti spremljen u SMART Notebook kao crtež. Ako SMART Notebook već nije otvoren, automatski se pokreće kada pokušate spremiti svoj odabir. Spremite datoteku svog SMART Notebooka koristeći opciju Datoteka > Spremi (File > Save).
Praktična vježba: osnovna funkcionalnost

Vaša škola ili tvrtka upravo je premjestila jednu od vaših interaktivnih ploča SMART Board u novu prostoriju jer niste mogli pristupati internetu na staroj lokaciji. Vi ćete biti prva osoba koja će koristiti interaktivnu ploču u novom okruženju i pokazat ćete svima kako se koristi interaktivna ploča zajedno s internetom.

Iz iskustva znate da kada god dobijete novu tehnologiju, dobro bi bilo testirati tu novu opremu prije nego što održite edukaciju ili prezentaciju. Računalo, interaktivna ploča SMART Board i projektor pokazuju
da rade ispravno kada sve uključite. Ipak, kada dvaput pritisnete ikonu internetskog preglednika na  radnoj površini, pokazivač je nekoliko centimetara udaljen od mjesta gdje ste pritisnuli prstom.
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Usmjeravanje interaktivne ploče SMART Board

Da vas podsjetimo, kada god projektor ili interaktivna ploča promijene položaj, potrebno je usmjeriti SMART Board. Ovaj postupak pokazuje računalu mjesto na površini interaktivne ploče gdje se prikazuje vaša radna površina.
1 
Kako biste usmjerili interaktivnu ploču, istovremeno pritisnite i držite gumbe Keyboard i Right
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Mouse sve dok se ne pojavi orijentacijski prikaz.
Gumbi na držaču za olovke
Gumbi na držaču za olovke
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Započnite orijentacijski proces u gornjem lijevom kutu orijentacijskog prikaza. Čvrsto pritisnite pomoću olovke ili svog prsta po sredini svakog križa prema redoslijedu koji pokazuje bijeli crtež u obliku dijamanta.
Orijentacijski prikaz
NAPOMENA: Točka je registrirana tek kada maknete svoj prst, a ne kada prvi put dotaknete orijentacijski prikaz

Testiranje osnovne funkcionalnosti

Bilo bi dobro provjeriti osnovnu funkcionalnost interaktivne ploče kako biste osigurali da sve aplikacije koje budete koristili tijekom svoje edukacije ili prezentacije rade ispravno.
1 
Koristeći se prstom, dvaput pritisnite na ikonu za internetski preglednik (npr. Internet
Explorer) kako biste pristupili internetu.
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Na držaču za olovke pritisnite gumb za virtualnu tipkovnicu na zaslonu.
3 
Unutar adresnog polja u internetskom pregledniku pritisnite jednom kako biste odabrali web adresu odredišta.
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Koristeći virtualnu tipkovnicu na zaslonu, upišite  www.google.com
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NAPOMENA: Virtualna tipkovnica na zaslonu jedina je točka kontakta; tipkanje dodirivanjem više tipki ili kombinacijom tipki nije moguće.
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5 
Pritisnite gumb Go pored adresnog polja vašeg internetskog preglednika.
6 
Već ste ranije odlučili da ćete pisati bilješke izravno preko Googleove™ web stranice tijekom svog predavanja ili prezentacije kako biste naglasili ključne točke.
Uzmite olovku iz držača za olovke. Primijetit ćete kako se pojavljuje prozirni sloj, u vidu vidljivog okvira oko radne površine. Okvir vas obavještava da možete pisati po radnoj površini, te ostaje aktivan sve dok sve olovke i brisač nisu vraćeni u držač za olovke, te dok niste dotaknuli interaktivnu pametnu ploču nakon toga.
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Pojavljuje se okvir prozirnog sloja
7 
Koristeći olovku, zaokružite gumb Back u internetskom pregledniku.
8 
Vratite olovku u držač za olovke i jednom dotaknite interaktivnu ploču kako biste obrisali krug oko gumba Back u internetskom pregledniku. Pritisnite gumb Click here to restore writing u donjem desnom kutu zaslona kako biste vratili natrag krug koji ste načinili.
[image: image12.png]Clck hereto
restore witing





Sada ste potvrdili da možete obrisati svoje bilješke dodirujući interaktivnu ploču te ih potom možete ponovno vratiti pritiskom na ikonu Clear here to restore writing.
9 
Kako biste se osigurali da ćete moći spremiti važne informacije za buduća predavanja ili prezentacije, ponovno uzmite olovku iz držača za olovke. Pritisnite gumb Snimanje zaslona / Area Capture na alatnoj traci Plutajući alati / Floating Tools.
Gumb Snimanje zaslona / Area Capture (za spremanje dijela radne površine)
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Alatna traka
Floating Tools
10 
Pritisnite interaktivnu ploču i ne popuštajući pritisak povucite selekcijski okvir koristeći  prst
kako biste napravili odabir oko kruga koji okružuje gumb Back u vašem internetskom pregledniku. Popustite pritisak kako biste spremili sliku u SMART Notebook.
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NAPOMENA: SMART Notebook automatski se otvara pa će vaše bilješke i pozadina biti spremljene na novu stranicu u SMART Notebooku.
11 
Dotaknite zaslon jednom kako biste obrisali krug oko gumba Back u svom  internetskom pregledniku.

12 
Odaberite nepohranjenu datoteku SMART Notebooka iz programske trake kako biste pogledali svoju spremljenu sliku u SMART Notebooku. Odaberite Datoteka > Spremi (File > Save) kako biste spremili svoje bilješke za buduću upotrebu.
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Opažanje     tinte
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Što j e opažanje tinte?
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Kada softver ima sposobnost opažanja tinte, to znači da možete pisati i crtati izravno u aktivnu datoteku. Na primjer, ako napišete bilješku ili nacrtate nešto tijekom korištenja Microsoft®    Worda, možete spremiti svoju Word datoteku, a vaše će bilješke biti vidljive i kada sljedeći put otvorite tu istu datoteku.
Kako rade aplikacije koje opažaju tintu?

Aplikacije koje opažaju tintu mogu prepoznati koji dio softvera je aktivna radna površina, a koji dio se koristi za gumbe i alatne trake.
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alatne trake
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Radna površina
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Koje aplikacije mogu opažati tintu?

Postoji na desetke aplikacija koje mogu opažati tintu, kao što je prikazano u tablici koja slijedi.
	Microsoft
Office
	Microsoft Word, Microsoft Excel®, PowerPoint®

	Grafičke aplikacije
	CorelDRAW®, Microsoft Imaging, Corel®Grafigo™ 2, Microsoft Paint

	Prezentacijske aplikacije
	PowerPoint, Corel Presentations™, Microsoft Office Live Meeting, Microsoft
NetMeeting®    3

	Ostale aplikacije
	AutoCAD®, VoloView Express™, AutoVue™ Professional, Microsoft Windows® Journal, Microsoft Office OneNote®, Microsoft Visio®, Adobe®Acrobat® Professional 6.0


Ovo će se poglavlje usredotočiti na najčešće korištene aplikacije – Microsoft Word, Microsoft Excel i
PowerPoint.
Microsoft Word

Pri korištenju Microsoft Worda s vašom interaktivnom pločom, uočit ćete tri nova gumba. Oni mogu biti integrirani u postojeću alatnu traku Worda ili mogu biti odvojeni kao zasebna plutajuća alatna traka.
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	Pritisnite kako biste svoje crteže ili bilješke izravno ubacili u svoj dokument kao sliku.
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	Pritisnite kako biste pretvorili svoje bilješke u tipkani tekst izravno u svom dokumentu. Vaš tekst će se pojaviti na mjestu pokazivača i u boji u kojoj su riječi bile napisane.
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	Pritisnite kako biste spremili prikaz cijelog zaslona u SMART Notebook.


Ako ne vidite nijednu od ovih alatnih traka, odaberite View > Toolbars > SMART Aware Toolbar u
Microsoft Wordu.
	Primjer: Pritiskanje gumba Insert as Image (za ubacivanje u obliku slike)

	Prije nego što pritisnete gumb, slika nije dio Microsoft Word datoteke. Moguće ju je jedino vidjeti na interaktivnoj ploči.
	Pritisnite gumb i slika će postati dio Microsoft Word datoteke. Sada možete poslati promjene koje sugerirate odgovarajućoj osobi.
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Umetanje slike u Word document      

Microsoft Excel

Pri korištenju Microsoft Excela s vašom interaktivnom pločom, uočit ćete tri nova gumba. Oni mogu biti integrirani u postojeću alatnu traku Excela ili  odvojeni kao zasebna plutajuća alatna traka.
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	Pritisnite kako biste svoje crteže ili bilješke izravno ubacili u Excel proračunske tablice kao sliku.
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	Pritisnite kako biste pretvorili svoje bilješke u tipkani tekst izravno u Excel proračunske tablice. Vaš tekst će se pojaviti na mjestu pokazivača i u boji u kojoj su riječi bile napisane.
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	Pritisnite kako biste spremili prikaz cijelog zaslona u SMART Notebook.


Ako ne vidite niti jednu od ovih alatnih traka, odaberite View > Toolbars > SMART Aware Toolbar u
Microsoft Excelu.
	Primjer: Pritiskanje gumba Insert as Text (za ubacivanje u obliku teksta)

	Prije nego što pritisnete gumb, slika nije dio Microsoft Excel datoteke. Moguće ju je jedino vidjeti na interaktivnoj ploči.
	Pritisnite gumb i slika će postati dio Microsoft Excel datoteke. Sada možete poslati promjene koje sugerirate odgovarajućoj osobi.
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PowerPoint

Kada prezentirate pomoću PowerPoint softvera na svojoj interaktivnoj ploči, možete spremiti svoje bilješke kao slike i možete spremati prikaze cijelog zaslona u Softversku bilježnicu, kao što to isto možete i kada koristite Microsoft Word ili Excel. Upotrijebite prezentacijsku alatnu traku kako biste pristupili[image: image161.png]
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 mogućnostima opažanja tinte unutar PowerPointa. Prezentacijska alatna traka pojavljuje se automatski pri pokretanju prezentacije u PowerPointu.
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Prezentacijska alatna traka
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Pomicanje na prethodni slajd  prezentacije

Otvaranje izbornika s naredbama

Pomicanje na sljedeći slajd u vašoj prezentaciji
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SAVJET: Tijekom PowerPoint prezentacije možete prijeći na sljedeći slajd tako da dva puta pritisnete na interaktivnu ploču, i to na način da drugi put pritisnete desno od prvog puta. Kako biste prešli na prethodni slajd, drugi put pritisnite lijevo od prvog pritiska.
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Izbornik s naredbama

Pritisnite središnji gumb na prezentacijskoj alatnoj traci za pokretanje izbornika s naredbama.
Sprema vaše bilješke izravno u Powerpoint prezentaciju
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Ubacuje dodatni slajd u vašu prezentaciju
Pokreće podizbornik s postavkama
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Završava prezentaciju

Sprema sliku trenutačnog slajda u Softversku bilježnicu
Briše vaše bilješke sa stranice
Pokreće podizbornik s naredbama za PowerPoint
Pokreće alatnu traku
Floating Tools
Podizbornik s naredbama za Powerpoint

Skače na bilo koji slajd u vašoj prezentaciji
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Zacrnjuje zaslon
Ispisuje trenutačni slajd  na vaš osnovni pisač
Otvara Powerpointov izbornik
SAVJET: Koristite naredbu Black/Unblack Screen (za zacrnjivanje zaslona) kada želite premjestiti fokus slušatelja sa zaslona na osobu koja prezentira. Pritisnite dva puta zaredom bilo gdje na zaslonu kako biste nastavili svoju prezentaciju točno na mjestu gdje ste stali.
Podizbornik s postavkama
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Deselektirajte ovu opciju kako biste slajdove mijenjali samo jednim pritiskom umjesto dva
Deselektirajte ovu opciju ako na kraju prezentacije ne želite biti pitani želite li spremiti svoje bilješke

Deselektirajte ovu opciju ako želite da alatna traka bude neprozirna

SMART Floating Tool
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Programska traka operativnog sustava i područje s obavijestima skriveni su tijekom vaše PowerPoint prezentacije. Ipak, uvijek možete pokrenuti alatnu traku Floating Tools birajući opciju SMART Floating Tools u izborniku s naredbama.
Grafički sažetak alata za opažanje tinte

	Alat
	Funkcija
	Aplikacija

	
	
	Word
	Excel
	PowerPoint
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	Ubacuje bilješke ili crteže kao sliku u dokumente ili proračunske tablice
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	Pretvara bilješke u tipkani tekst i ubacuje ih u dokumente ili proračunske tablice
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	Sprema vidljivo aktivno radno područje u Softversku bilježnicu
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	Otvara izbornik s naredbama koji omogućava obuhvat i spremanje vaših bilješki, kao i prilagodbu raznih početnih postavki
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	Pomiče vašu PowerPoint prezentaciju jedan slajd naprijed
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	Pomiče vašu PowerPoint prezentaciju jedan slajd unatrag
	[image: image48.png]




	[image: image49.png]




	[image: image50.png]






SAVJETI:
1   Upotrebljavajte gumbe na alatnoj traci za opažanje tinte kako biste pretvorili svoje bilješke izravno u Microsoft Wordu i Excelu.
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2   Prezentacijska alatna traka u PowerPointu omogućava upravljanje PowerPoint prezentacijom dok se fizički nalazite na svojoj interaktivnoj ploči SMART Board.
3   Alatnu traku Floating Tools možete pokrenuti tijekom PowerPoint prezentacije odabirući Slide
Show Toolbar > Command Menu > SMART Floating Tools.
Program SMART Notebook
Što je SMART Notebook? 
SMART Notebook je program za korištenje interaktivne ploče SMART Board. Koristite ga kao što biste koristili papirnatu bilježnicu za pisanje tekstova i izradu skica. SMART Notebook također vam omogućava ubacivanje multimedijalnih elemenata kao što su slike i Macromedia®  Flash®   datoteke unutar datoteke SMART Notebooka.
Korištenje SMART Notebooka prvi put

Kako biste pokrenuli Softversku bilježnicu, pritisnite ikonu SMART Board u notifikacijskom području u Windowsima u donjem desnom kutu svog zaslona,
te izaberite opciju Notebook. Ili, pritisnite gumb Start u donjem lijevom kutu svog zaslona te odaberite Programs > SMART Board Software >  SMART Notebook.
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Otvorit će se nova datoteka SMART Notebooka. Svaka nova datoteka SMART Notebooka sadrži radno područje koje se može popuniti objektima. Rukom pisani tekst, tipkani
tekst, grafika, crteži i Flash datoteke, sve su to primjeri objekata koje možete dodavati u datoteku SMART Notebooka.
Ključna funkcija SMART Notebooka je mogućnost  dodavanja onoliko stranica koliko vam je potrebno da obuhvatite ili prikažete informacije.
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Notifikacijsko područje u Windowsima
Alatna traka SMART Notebooka
Alatna traka SMART Notebooka omogućava vam pristup brojnim alatima koji vam pomažu u radu s vašom datotekom SMART Notebooka. Prema početnim postavkama, alatna se traka pojavljuje na vrhu stranice SMART Notebooka. Ako više volite sjediti ili radite s mlađim učenicima, možda će vam biti zgodnije da alatnu traku pomaknete na dno stranice. Kako biste to učinili, pritisnite strelicu prema dolje koja se nalazi na kraju desne strane alatne trake.
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	Gumb
	Upotrijebite ovaj alat kako biste
	Gumb
	Upotrijebite ovaj alat kako biste
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	prikazali prethodnu stranicu u
Bilježnici
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	pokrenuli alatnu traku za pohranu slike zaslona
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	prikazali sljedeću stranicu u Bilježnici
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	umetnuli tablicu
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	iza aktivne stranice izravno ubacili praznu stranicu u Bilježnicu
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	odabrali bilo koji objekt na stranici  prstom ili mišem
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	otvorili postojeću datoteku SMART Notebooka
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	pisali ili crtali na stranici SMART Notebooka  olovkom za pisanje
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	spremili svoju stranicu u Bilježnicu
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	pisali ili crtali na stranici SMART Notebooka  kreativnom olovkom za pisanje
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	zalijepili kopirane objekte u svoju datoteku SMART Notebooka
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	obrisali digitalnu tintu na stranici
SMART Notebooka
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	poništili svoju posljednju izvršenu radnju
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	nacrtali liniju
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	ponovili svoju posljednju izvršenu radnju
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	kreirali oblik
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	obrisali bilo koji označeni objekt
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	stvorili okvir za unos tipkanog teksta
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	uključili/isključili sjenilo zaslona na trenutačnoj stranici SMART Notebooka
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	upotrijebili olovke za prepoznavanje oblika
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	pokrenuli pregled preko cijelog zaslona
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	upotrijebili čarobnu olovku
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	postavili prozirnu pozadinu
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	postavili boju alata za crtanje ili označenog oblika
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	prikazali dvije stranice na zaslonu
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	odabrali svojstva linija alata za crtanje ili označenog oblika
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	aktivirali SMART Document cameru
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	premjestili alatnu traku na dno stranice SMART Notebooka


Izbornici
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Izbornici SMART Notebooka omogućavaju pristup brojnim istim alatima i funkcijama koje se nalaze na alatnoj traci SMART Notebooka, ali i nekim alatima koji se ne nalaze na alatnoj traci.
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	Stavka izbornika
	Funkcija

	Datoteka / File
	•  Otvaranje novih ili postojećih datoteka
•  Spremanje datoteka
•  Spremanje trenutačne stranice kao stavke unutar Galerije
•  Izvoz sadržaja u raznovrsnim datotečnim oblicima
•  Uvoz PowerPoint datoteke
•  Slanje datoteke e–poštom u obliku datoteke SMART Notebooka ili kao PDF
•  Ispis datoteka ili prilagodba postavki ispisa

	Uredi / Edit
	•  Poništavanje ili ponavljanje ranijih radnji
•  Kloniranje, rezanje, kopiranje, lijepljenje ili brisanje označenih objekata ili svih objekata na stranici
•  Uređivanje teksta
•  Provjera pravopisnih pogreški za sve tekstove unutar datoteke
•  Čišćenje ili brisanje trenutačne stranice

	Pogledaj / View
	•  Promjena postojećeg pogleda (Page Sorter, Galerija, Attachments ili prikaz preko cijelog zaslona)
•  Skrivanje bočne pomične trake
•  Pokretanje alata za pohranu slike zaslona ili alata za sjenilo zaslona
•  Zumiranje za uvećavanje ili smanjivanje pogleda na sadržaj stranice
•  Pomicanje na sljedeću ili prethodnu stranicu

	Umetni / Insert
	•  Dodavanje praznih stranica, crteža, grafika, Flash datoteka ili hiperveza

	Format
	•  Izmjena svojstava fontova (masno, podcrtano, kurziv)
•  Promjena svojstava objekata (boja, debljina linije, stil linije, popuna, prozirnost)

•  Zaključavanje svojstava i pozicije objekata
•  Izmjena boje pozadine stranice

	Crtaj / Draw
	•  Kreiranje oblika, linija i tekstova
•  Pristupanje alatima za pisanje, kreativno pisanje te brisanje
•  Poredak, grupiranje, razbijanje grupe ili preokretanje označenih objekata

	Pomoć / Help
	•  Pristupanje informacijama o Softverskoj bilježnici
•  Provjera dostupnosti nadogradnje softvera


Bočne kartice

Na desnoj strani sučelja SMART Notebooka nalaze se četiri kartice kao na slici.
Pritisnite gumb sa strelicom kako biste premjestili sve kartice na drugu stranu svoje stranice – često je to bolja lokacija ako prezentator stoji na drugoj strani ploče.
Kartice možete ukloniti kada ste završili s njima označujući kvačicom kućicu Automatski sakrij (Auto–hide).
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	Prikazuje umanjene slike svake stranice u vašoj datoteci SMART


	
	Pristup zbirkama prilagođenih stranica, crteža, Flash animacija i video isječaka koje možete dodavati u svoje datoteke SMART Notebooka


	
	Pritisnite karticu kako biste dodali hiperveze ili privitke iz drugih aplikacija u svoju datoteku


	
	Kartica za podešavanje efekata ispune i snimanje prezentacije


	
	


	Razvrstavač stranica (Page Sorter)
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Odaberite karticu Razvrstavač stranica (Page Sorter) kako biste vidjeli višestruke umanjene prikaze svih stranica u svojoj datoteci SMART Notebooka.
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Aktivna stranica signalizirana je padajućim izbornikom i plavim okvirom oko umanjene slike stranice. Označavanje neke druge stranice u kartici Razvrstavač stranica (Page Sorter) čini tu stranicu aktivnom te se njezin sadržaj prikazuje u radnom području. Kako biste promijenili redoslijed stranica, označite umanjenu sliku stranice i povucite je na novu lokaciju.
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Aktivna stranica


	Padajući izbornik kartice Razvrstavač stranica (Page Sorter) 

Odabirući padajući izbornik na aktivnoj stranici, dolazi se do sedam opcija.
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	Stavka izbornika
	Funkcija

	Izbriši stranicu / Delete page
	Briše trenutačnu stranicu

	Obriši stranicu / Clear page
	Uklanja sve objekte na trenutačnoj stranici

	Umetni praznu stranicu / Insert blank page
	Dodaje praznu stranicu odmah iza aktivne stranice

	Kloniraj stranicu / Clone page
	Kreira istovjetnu stranicu, uključujući i sve objekte na stranici, te ubacuje tu stranicu odmah iza aktivne stranice

	Preimenuj stranicu / Rename page
	Omogućava promjenu imena stranice

	Sjenčanje zaslona / Screen Shade
	Prekriva aktivnu stranicu sjenilom zaslona

	Dodaj stranicu u Galeriju / Add Page to Gallery
	Dodaje trenutačnu stranicu u Galeriju.


Objekti u programu SMART Notebook
Bilo što što možete odabrati unutar radnog područja stranice SMART Notebooka jest objekt. Objekte je na stranice SMART Notebooka moguće dodavati korištenjem bilo koje od sljedećih metoda:
•  pisanjem teksta
•  crtanjem ili pisanjem po radnom području olovkom
•  kreiranjem geometrijskog oblika pomoću alata za crtanje na alatnoj traci SMART Notebooka
•  ubacivanjem sadržaja iz Galerije, vašeg računala ili s Interneta
Mijenjanje i premještanje objekata 
Izaberite bilo koji objekt na svojoj stranici SMART Notebooka kako biste izmijenili njegova svojstva. Odabrani objekti imaju dvije ručke. Upotrijebite zelenu ručku kako biste rotirali objekt i bijelu ručku kako biste objekt povećali ili smanjili.
Kako biste premjestili objekt s jedne stranicu
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na drugu, pobrinite se da je kartica Page Sorter aktivna, te da kućica Auto–hide nije označena. Tada označite objekt koji želite premjestiti te ga povucite na odgovarajuću stranicu.



[image: image192.png]


Povucite u smjeru  kazaljke na satu ili obrnuto kako biste zarotirali objekt


Pritisnite za otvaranje padajućeg izbornika
Povucite za promjenu veličine objekta
Padajući izbornik objekta

Padajući izbornik objekta omogućava pristup svojstvima objekta jednim klikom.
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	Stavka izbornika
	Funkcija

	Kloniraj / Clone
	Izrađuje kopiju objekta i ubacuje ga na aktivnu stranicu

	Izreži / Cut
	Briše objekt sa stranice i postavlja ga u međuspremnik

	Kopiraj / Copy
	Kopira objekt u međuspremnik

	Zalijepi / Paste
	Postavlja objekt iz međuspremnika na aktivnu stranicu

	Izbriši / Delete
	Brisanje objekta (objekt nije moguće izbrisati potpuno ili djelomično gumicom)

	Provjeri pravopis Check Spelling
	Provjera pravopisa (npr. engleskog; nije trenutačno raspoloživa za hrvatski jezik)

	Zaključavanje / Locking
	Zaštita svojstava na objektu

	Grupiranje / Grouping
	Spaja dva ili više objekta u zajednički objekt

	Obrni / Flip
	Zrcalno preslikavanje objekta

	Redoslijed / Order
	Određuje poredak objekata

	Beskonačno kloniranje / Infinite Cloner
	Reproduciranje neograničenog broja istovjetnih objekata bez potrebe za stalnim ponavljanjem opcije Kloniraj / Clone

	Poveži / Link
	Povezivanje objekta s internetskim odredištem, drugom stranicom u SMART Notebook programu ili drugom datotekom

	Zvuk / Sound
	Povezivanje objekta sa zvučnom datotekom

	Svojstva / Properties
	Pokretanje dijaloškog okvira za promjenu svojstava objekta
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Zaključavanje objekata 
Zaključavanje objekta omogućava zaštitu svojstava koja su primijenjena na taj objekt. Mogućnosti
u podizborniku Locking omogućavaju vam da odredite koju vrstu zaključavanja želite koristiti na objektu.
Odaberite opciju Lock In Place kako biste osigurali da objekt ne može biti pomaknut ili promijenjen na bilo koji način.

Odaberite opciju Allow Move kako biste omogućili pomicanje objekta, ali ne i njegovo mijenjanje, rotiranje ili izmjenu bilo kojega svojstva. Možda ćete koristiti opciju Allow Move ako budete kreirali datoteku SMART Notebooka koja bi se koristila za učenje o redoslijedu objekata, ali bi se pritom željeli osigurati da svi objekti na stranici ostanu iste veličine.
Odaberite opciju Allow Move and Rotate kako biste omogućili pomicanje i rotiranje objekta, ali ne i promjenu njegove veličine. Možda ćete koristiti opciju Allow Move and Rotate prilikom kreiranja datoteke SMART Notebook-a sa dijelovima slagalice koje bi vaši učenici trebali posložiti u cjelinu. Dijelove slagalice možete smjestiti bilo gdje želite na stranici SMART Notebook-a, te ih možete zarotirati kako biste učinili slaganje još zahtjevnijim – bez da se morate brinuti da će sudionici slučajno promijeniti veličinu dijelova.
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Otključajte objekt sljedećim radnjama:
1   Odaberite zaključani objekt. Pojavljuje se ikona lokota.
    Odaberite ikonu lokota.
3   U izborniku odaberite opciju Unlock.
Grupiranje objekata

Odaberite dva ili više objekta tako da pritisnete i vučete prstom ili mišem dijagonalno kako bi objekti bili okruženi selekcijskim okvirom. Pritisnite padajući izbornik na bilo kojem od objekata te izaberite opciju Grouping > Group.
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Ako želite razdvojiti objekte, ponovno označite grupirane objekte te izaberite opciju Grouping > Ungroup. Ova funkcija također će razdvojiti rukom pisane bilješke u individualne poteze olovkom.
Preokretanje objekta

Odaberite opciju Flip iz padajućeg izbornika objekta kako biste ga preokrenuli vodoravno ili okomito.
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Prije

Poslije
Poredak objekata

Možete promijeniti redoslijed prema kojem su objekti raspoređeni birajući opciju Order iz padajućeg izbornika.
Kako biste mijenjali redoslijed objekta jedan po jedan sloj, koristite naredbe Bring Forward i Send Backward.
Kako biste premjestili objekt izravno na prvi gornji sloj stranice, koristite naredbu Bring to Front.
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Četiri objekta poredana na dva različita načina
Kako biste poslali objekt na posljednji sloj stranice, koristite naredbu Send to Back.
Beskonačno kloniranje

Opcija Infinite Cloner iz padajućeg izbornika objekta omogućava vam reproduciranje objekta u neograničenom broju, tako da
ne morate svaki put ponovno odabirati opciju za kloniranje iz padajućeg izbornika. Beskonačno kloniranje možete primijeniti kod učenja brojenja ili za prezentiranje matematičkih problema.
Odaberite opciju Infinite Cloner iz padajućeg izbornika
objekta. Sada se svaki put kad izaberete objekt pojavljuje znak beskonačnosti u gornjem desnom kutu objekta.
Kada pritisnete i vučete objekt koji je postavljen na beskonačno kloniranje, kreira se još jedan istovjetni objekt. Možete nastaviti kreirati klonove objekta vukući ga sve dok ne isključite opciju Infinite Cloner.
Isključite svojstvo beskonačnog kloniranja odabirući znak beskonačnosti u gornjem desnom kutu objekta te birajući stavku Infinite Cloner u izborniku.
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Odaberite, potom pritisnite i vucite objekt kako biste kreirali identični objek.
Dodavanje veza na objekte

Objekte je moguće povezati s internetskim odredištem, nekom drugom stranicom u Bilježnici, datotekom na vašem računalu ili datotekom koja se nalazi u kartici Attachments.
Odaberite opciju Link iz padajućeg izbornika objekta, te iz dijaloškog okvira za umetanje veza odaberite vrstu veze koju biste željeli dodati na svoj objekt.
	Vrsta veze
	Upotrijebite ovo za:
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	Povezivanje objekta s internetskom stranicom. Jednom kada je link pridružen objektu, svaki put kada ga pritisnete, vaš će se internetski preglednik pokrenuti i prikazati traženu stranicu.
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	Povezivanje s drugom stranicom unutar vaše datoteke SMART Notebooka. Ovu vrstu veze možete upotrijebiti kada prezentirate pitanje. Na primjer, možete postaviti pitanje, te potom ponuditi učenicima na biranje set objekata koji predstavljaju potencijalne odgovore. Objekt koji sadrži točan odgovor mogao bi imati vezu na nagradni prozor; objekti koji sadrže netočne odgovore mogu biti povezani sa stranicom koja potiče studente da ponovno pokušaju.
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	Povezivanje s datotekom pohranjenom na vašem računalu koja je u vezi s vašom prezentacijom ili predavanjem. Na primjer, mogli biste povezati Microsoft Word ili Excel datoteku koja sadrži informacije koje potkrjepljuju izjave u vašoj datoteci SMART Notebooka.
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	Povezivanje s datotekom koju ste pohranili u kartici Attachments. Kartica
Attachments bit će kasnije detaljno obrađena u ovom priručniku.


Prema inicijalnim postavkama, možete pokrenuti svoju povezanu internetsku stranicu ili datoteku iz objekta tako da pritisnete ikonu koja se pojavljuje u donjem lijevom kutu povezanog objekta.
Kako biste uklonili vezu, odaberite povezani objekt. Odaberite opciju Link iz padajućeg izbornika objekta i pritisnite gumb Remove Link.
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Zvuk

Unaprijedite svoje predavanje zvukom povezujući objekt s MP3 zvučnom datotekom.

Kako biste povezali zvučnu datoteku s objektom, slijedite ove upute:
1 
Odaberite opciju Sound iz padajućeg izbornika objekta kako biste pokrenuli dijaloški okvir za ubacivanje zvuka.
 
Pritisnite gumb Browse.
3 
Pronađite zvuk koji želite povezati s odabranim objektom.
 
Nakon što odaberete zvučnu datoteku, njezino će se ime pojaviti u tekstualnom polju Sound to play. Pritisnite gumb OK kako biste povezali zvuk sa svojim objektom.
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SAVJET: Pritisnite gumb Play kako biste čuli zvuk prije nego što ga povežete sa svojim objektom.
Svojstva

Odaberite opciju Properties iz padajućeg izbornika kako biste pokrenuli dijaloški okvir za odabir svojstava, te promijenite boju, svojstva linija te prozirnost objekta.
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Prepoznavanje rukopisa

Ako ste nešto napisali koristeći alat olovku u Softverskoj bilježnici, dostupna vam je mogućnost prepoznavanja vašeg rukopisa i njegova pretvaranja u tipkani tekst.
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Kako biste pretvorili rukom pisanu riječ u tekst, odaberite padajući izbornik objekta te izaberite svoju riječ iz dostupnog popisa.
Tipkani tekst

Kako biste dodali tipkani tekst kao objekt u svoju datoteku SMART Notebooka, morate pretvoriti rukom pisane bilješke u tipkani tekst ili tekst morate natipkati pomoću tipkovnice te pritisnuti Enter kada budete gotovi.
Alatna traka za fontove pojavljuje se dok tipkate ili nakon što dva puta pritisnete tekstualni objekt. Koristite je za oblikovanje svojstava teksta, kao što su veličina pisma, boja, poravnanje, te opcije za eksponente. Brojne matematičke znakove pronaći ćete korištenjem zadnje ikone na desnoj strani alatne trake.
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Provjera pravopisa Odaberite opciju Check Spelling iz padajućeg izbornika kako biste provjerili pravopis tekstualnog objekta.
Dijaloški okvir provjere pravopisa pojavit će se s popisom predloženih pravopisnih rješenja ako je pravopis odabranog objekta neispravan. Odaberite ispravnu pravopisnu varijantu tekstualnog objekta iz liste predloženih pravopisnih rješenja, te pritisnite gumb Change kako biste ispravili netočnu riječ.
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SAVJET: Odaberite Edit > Spelling Check iz izbornika SMART Notebooka kako biste provjerili pravopis svih tekstualnih objekata u svojoj datoteci SMART Notebooka.
Alati za crtanje

Koristite alate za crtanje – koji su dostupni iz alatne trake
SMART Notebooka – kako biste kreirali svoje objekte.
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Alat olovka i alat za brisanje
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Odaberite ili alat olovku ili kreativnu olovku iz alatne trake SMART Notebooka. Pritisnite na površinu te povucite ili  svojim prstom ili olovkom kako biste kreirali objekt.
Odaberite alat za brisanje kako biste obrisali bilo što što ste napravili alatom olovkom.
Alat za linije

Pritisnite gumb Line na alatnoj traci SMART Notebooka kako biste crtali ravne linije. Odaberite bilo koju liniju napravljenu alatom za linije, te povucite krajnje točke kako biste liniju rastegnuli ili promijenili njezin nagib.
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Vucite
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SAVJET: Držite tipku Shift dok zakrećete liniju pa će se linija usmjeriti svakih 45°.
Alat za oblike

Unaprijedite bilo koju aktivnost pomoću alata za oblike na alatnoj traci SMART Notebooka.
Kreiranje oblika
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1 
Pritisnite strelicu prema dolje koja se nalazi pored gumba za oblike na alatnoj traci SMART Notebooka i pojavit će se izbornik s oblicima.
 
Odaberite oblik koji biste željeli koristiti, te postavite pokazivač na stranici gdje biste htjeli kreirati vaš oblik.
3 
Pritisnite i vucite vaš pokazivač dok oblik nije željene veličine.
Jednom kada se oblik nađe na stranici SMART Notebook-a, on može biti izmijenjen na isti način kao što se mijenjaju ostali objekti, korištenjem ručke za rotiranje, ručke za promjenu veličine ili uporabom padajućeg izbornika.
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SAVJET: Koristeći alat za pokazivanje, dvostruko pritisnite objekt kreiran pomoću alata za oblike kako biste mu dodali naziv.
Prilagođavanje alata za crtanje

Pored svakog alata za crtanje postoji strelica koja otvara padajući izbornik. Pritisnite je kako biste birali između dostupnih opcija vezanih za taj alat.
Neki od padajućih izbornika pružaju mogućnost prilagodbe odabranog alata
Umetanje slika u Softversku bilježnicu

Kako biste dodali sliku u svoju datoteku SMART Notebooka, možete učiniti sljedeće:
•  Koristite alatnu traku za pohranu slike zaslona kako biste spremili slike na svom zaslonu.
•  Koristite izbornik Insert kako biste uvezli grafiku ili crtež iz neke druge lokacije na računalu.
Alatna traka za pohranu slike zaslona

Alatna traka za pohranu slike zaslona omogućava vam spremanje slike vašeg zaslona, prozora ili dijela vašeg zaslona, u stranicu SMART Notebooka. Kako biste pristupili ovoj alatnoj traci, pritisnite gumb Capture (ikona kamere) na alatnoj traci SMART Notebooka.
	Gumb
	Kako ga koristiti
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	Pritisnite i vucite kako biste označili kvadratno područje koje želite pohraniti. Popustite pritisak nakon što je područje označeno.
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	Pritisnite unutar prozora koji želite pohraniti. Popustite pritisak nakon što se željeni prozor pojavi kao rešetkasto područje.
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	Upravljajte do zaslona koji želite pohraniti, te pritisnite gumb kako biste pohranili cijeli zaslon.
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	Pritisnite i vucite kako biste kreirali slobodni oblik oko područja koje želite pohraniti. Popustite pritisak nakon što je područje označeno.


Ubacivanje slika pomoću izbornika Insert

Ubacite sliku iz datoteka na svom čvrstom disku ili mreži odabirući Insert > Picture File, te koristeći dijaloški okvir kako biste našli i ubacili svoju sliku.
Možete ubacivati tiskane materijale, npr. gornje prozirne listove ako je skener spojen na vaše računalo.
1 
Odaberite Insert > Picture From Scanner.
Pojavljuje se dijaloški okvir za ubacivanje skeniranih slika.
 
Odaberite skener iz popisa.
3 
Pritisnite gumb Scan.
 
Skenirajte svoju sliku i prilagodite je po potrebi, prateći upute koje su došle uz softver za skeniranje.
5 
Kada je skeniranje završeno, zatvorite dijaloški okvir i vratite se u Softversku bilježnicu.
Galerija

Galerija SMART Notebooka pomaže vam da brzo razvijete i izradite prezentacije bogate grafičkim detaljima. Tisuće slika, stranica, video datoteka, Flash datoteka i cijelih datoteka Bilježnica organizirane su u pretražive zbirke koje će vam omogućiti kreiranje privlačnih i višenamjenskih predavanja.
Pokreće virtualnu tipkovnicu na zaslonu
Pritisnite kako biste vidjeli rezultate svojih prethodnih pretraga – funkcionira na sličan način kao i gumb Back u internetskom pregledniku
Odaberite mapu i umanjene slike njezina sadržaja bit će prikazane
u donjem prozoru Galerije

Pritisnite za pretraživanje sadržaja
Galerije prema ključnoj riječi

Pritisnite kako biste pogledali rezultate pretrage u donjem prozoru Galerije
Pritisnite kako biste uvezli sadržaj u područje svojih sadržaja unutar Galerije
Pritisnite karticu Gallery kako biste otvorili Galeriju
Odaberite umanjenu sliku i povucite je na radno područje
Pronalaženje sadržaja u Galeriji

Postoje dva načina za pronalaženje sadržaja unutar Galerije.
Polje za pretragu na vrhu kartice Gallery
omogućava pretraživanje pomoću ključne riječi 
–
slično korištenju internetskog pretraživača. Također možete i pregledavati zbirke unutar Galerije tako da odaberete željenu mapu.
Upotrijebite funkciju pretraživanja Galerije ako tražite specifičan sadržaj vezan uz neku ključnu riječ, kao što je Afrika. Pregledavajte individualne mape ako tražite sve objekte
vezne uz neku opću temu, kao što je zemljopis.
Kako biste pronašli objekte unutar Galerije korištenjem polja za pretraživanje, slijedite ove upute:
1 
Pritisnite jednom unutar polja za pretraživanje.
 
Upišite ključnu riječ vezanu uz vrstu objekta koji tražite.
3 
Pritisnite gumb za pretraživanje kako biste dobili rezultate.
SAVJET: Pokrenite virtualnu tipkovnicu na zaslonu pritiskom na ikonu pored gumba za pretragu.
Objekti u Galeriji

Objekti su organizirani u donjem dijelu Galerije u nekoliko područja: Related Folders, Pictures and Backgrounds, Interactive and Multimedia, Notebook Files and Pages i Lesson Activities.
Dvostrukim pritiskom na umanjenu sliku mape u području povezanih mapa (Related Folders) pojavljuju se svi objekti koje ta mapa sadrži.
Područje Pictures and Backgrounds sadržava pozadine i objekte, npr. grafike, fotografije ili tekst. Možete povući objekt na radnu površinu kako biste ga koristili kao dio predavanja ili kako biste promijenili njegova svojstva. Povucite pozadinu na svoju stranicu SMART Notebooka te će se boja i dizajn pozadine stranice poistovjetiti sa svojstvima odabrane pozadine u Galeriji. Pozadine se raspoznaju po savijenom donjem desnom kutu te se uvijek smještaju iza svih trenutačno prisutnih objekata na stranici SMART Notebooka.
Područje Interactive and Multimedia sadrži Flash, video datoteke i objekte sa zvučnim privicima. Objekti u ovoj mapi se koriste za dodavanje bogatih medijskih sadržaja u predavanje ili prezentaciju.
Dodatne datoteke i stranice mogu se pronaći u područjima Notebook Files and Pages i Lesson Activities unutar Galerije. Umanjene slike stranica prepoznaju se po savijenom gornjem desnom kutu.  Datoteke SMART Notebooka i aktivnosti s predavanja prepoznaju se po spiralnom uvezu s lijeve strane njihove umanjene slike. Povlačenjem umanjene slike stranice, datoteke SMART Notebooka, ili aktivnosti s predavanja, na radno područje, ubacuje se nova stranica u Bilježnicu ili serija stranica odmah iza aktivne stranice.
Internetski izvori

Odaberite opciju Online Resources kako biste pristupili aktivnostima s predavanjima, standardnim nastavnim planovima, razrednim resursima ili dodatnim sadržajima Galerije na Internetu.
NAPOMENA: Za pristupanje internetskim resursima potrebna je aktivna internetska veza i web preglednik.
Vlastiti sadržaji

Područje My Content je zbirka unutar Galerije specijalno rezervirana za objekte koje ste uvezli, pohranili ili kreirali. Ovo je dobro mjesto za spremanje objekata koje ćete koristiti u više prezentacija.
Kako biste dodali objekt u područje svojih sadržaja, povucite ga iz radnog područja u područje nazvano My Content.
Ako često koristite specifičan raspored elemenata na stranici, možete spremiti stranicu SMART Notebooka kao umanjenu sliku u područje sa svojim sadržajima. Svi objekti povezani s pohranjenom stranicom zadržavaju svoja svojstva. Kako biste ponovno upotrijebili pohranjenu stranicu, povucite njezinu umanjenu sliku iz područja svojih sadržaja na radno područje.
Također možete pohraniti cijelu datoteku SMART Notebooka u područje svojih sadržaja. Ovo ćete možda htjeti učiniti ako neku prezentaciju dajete više puta. Kako biste pokrenuli datoteku SMART Notebooka iz područja vlastitih sadržaja, povucite je na radno područje.
Kako biste ubacili datoteke sa svog računala, slijedite ove upute:
1 
Odaberite ikonu Gallery Actions koja se nalazi s desne strane gumba za pretraživanje.
 
Odaberite opciju Add Other Files to My Content kako biste pokrenuli dijaloški okvir za dodavanje svojih sadržaja.
3 
Pronađite datoteku koju želite dodati.
 
Odaberite datoteku koju želite dodati.
5 
Pritisnite gumb Open.
Vaša će se datoteka pojaviti kao umanjena slika u području vlastitih sadržaja u Galeriji.
Dodavanje ključnih riječi objektima u području vlastitih sadržaja

Funkcija pretraživanja u Galeriji radi na način da pregledava ključne riječi povezane sa svakim objektom u Galeriji. Kada dodate objekt u područje svojih sadržaja unutar Galerije, možete unijeti i ključne riječi za objekt kako bi on kasnije mogao biti pronađen tijekom pretraživanja.
Kako biste dodali ključne riječi objektu u svojim sadržajima, učinite sljedeće:
1 
Pritisnite umanjenu sliku objekta u području svojih sadržaja.

2
Pritisnite padajući izbornik.
3 
Odaberite opciju Properties iz popisa kako biste pokrenuli dijaloški okvir za postavljanje svojstava objekata u Galeriji.
4
Upišite ključne riječi kojima želi opisati objekt. Na
primjer, možete napisati gitara, glazba i strune ako je objekt iz Galerije slika gitare.
5 
Pritisnite OK.
Pri pretraživanju koristite se dodijeljenim ključnim riječima kako biste pronašli objekt.
Kartica Attachments

Povežite svoje prezentacije i predavanja. Kartica Attachments omogućava vam da povežete razne dokumente i internetske stranice izravno iz svoje datoteke SMART Notebooka.

Kako biste ubacili datoteku, pritisnite gumb Insert, koji se nalazi na dnu kartice Attachments, te locirajte datoteku ili upišite internetsku adresu koju biste htjeli dodati u područje s privicima. Kako biste otvorili datoteku ili internetsku stranicu iz kartice Attachments, dvaput pritisnite na njezino ime.
Dijeljenje vaše datoteke SMART Notebooka
Postoji nekoliko načina kako možete podijeliti svoju datoteku SMART Notebooka s kolegama koji koriste Softversku bilježnicu. Najjednostavniji način je da spremite svoju datoteku SMART Notebooka – odaberite File > Save – te im omogućite pristup do nje.
Svoje vrijedne sadržaje također možete podijeliti odabirući File > Export te spremajući ih u obliku internetske stranice za korisnike koji nemaju instaliran SMART Notebook na svom računalu. Sadržaj također može biti izvezen kao serija slikovnih datoteka ili kao PDF. Ako želite dodati prijelaze svojim slajdovima, možete izvesti svoju datoteku SMART Notebooka kao PowerPoint datoteku.
Virtualni pisač SMART Notebooka
Virtualni pisač vam omogućava dodavanje cijeli višestraničnih datoteka iz drugih aplikacija, kao što je Microsoft Word, ili dugih internetskih stranica, u vašu datoteku SMART Notebooka. Ovu funkciju mogli biste koristiti prilikom rasprave o sadržaju neke internetske stranice, tako da biste mogli pisati svoje bilješke u odgovarajućem kontekstu.
Virtualno ispisivanje slično je ispisivanju na papir. Za svaku stranicu koja bi se inače pojavila na zasebnom papiru, kreira se nova stranica u Bilježnici.
Kako biste ispisali sadržaj datoteke ili internetske stranice u Softversku bilježnicu, učinite sljedeće:
1 
Otvorite datoteku ili internetsku stranicu koju želite ubaciti u Softversku bilježnicu.
 
Odaberite File > Print – vrijedi za bilo koju aplikaciju iz koje inače možete ispisivati
3 
Kada se pojavi dijaloški okvir ispisa, iz popisa dostupnih pisača odaberite opciju SMART
Notebook Print Capture.
 
Pritisnite OK kako biste ispisivali u datoteku SMART Notebooka.
SMART Board alati
Zašto bih koristio SMART Board alate?
SMART Board alati uključuju funkcije koje omogućavaju učinkovitije rukovanje interaktivnom pločom. SMART Board alati također uključuju multimedijalne alate koji vam omogućavaju kreiranje i
prezentiranje dinamičkih sadržaja.
Pristupanje SMART Board alatima

Pritisnite ikonu SMART Board u notifikacijskom području operativnog sustava Windows, koje se nalazi u donjem desnom kutu vašeg zaslona, kako biste pristupili izborniku za SMART Board alate ili, ako ne postoji, treba pokrenuti opcije START – (SMART Tehnologies) - SMART Product Drivers – SMART Board Tools. 
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NAPOMENA: SMART Notebook detaljno je obrađen u prethodnom poglavlju ovih uputa; virtualna tipkovnica na zaslonu te funkcija orijentiranja obrađeni su u poglavlju Kako započeti.
SMART Recorder

Pomoću SMART Recordera možete napraviti videodatoteku bilo čega što radite na interaktivnoj ploči, bez obzira koju aplikaciju koristite. Zatim možete pustiti snimku na bilo kojem računalu koje ima SMART Video Player ili Windows Media Player (besplatno dostupan na adresi www.windowsmedia.com/download).

Sučelje s tri gumba omogućava vam nadzor nad procesom snimanja.

SMART Recorder – Padajući izbornik gumba za snimanje
Kako biste pristupili padajućem izborniku gumba za snimanje, odaberite strelice pored gumba za snimanje. Možete odabrati koji će dio radne površine biti sniman. Prema inicijalnim postavkama, SMART Recorder će snimati cijelu radnu površinu.
Record Desktop: Snima svaku radnju koju obavite na radnoj površini.
Record Area: Pita vas da odaberete dio zaslona koji biste željeli snimati.
Record Window: Pita vas da odaberete prozor koji biste željeli snimati.


Snimanje
Pauza
Stop
SMART Recorder – Izbornik

Promjena audio i
videopostavki
Izmjena formata snimljenog videa iz SMART Recorder videoformata u datoteku koju
je moguće gledati na bilo kojem računalu koje ima Microsoft Windowse
Prikaz pravnih i tehničkih informacija o SMART Recorderu
Opcije snimača Odaberite stavku Options u izborniku snimača kako biste pokrenuli dijaloški okvir koji
vam omogućava kontrolu audio
i videopostavki. Na primjer, možete promijeniti broj sličica koje se snime u sekundi. Filmovi koji su snimljeni
s manjim brojem sličica u sekundi imaju manju veličinu datoteke od onih s većim brojem sličica u sekundi, no vizualna kvaliteta takvog filma je smanjena.
Kartica Video Format
omogućava vam odabir
formata datoteke za spremanje  filmova. Opcija Microsoft Video kreira datoteku koja može biti pogledana pomoću bilo kojeg Windows Media Playera. Opcija SMART Recorder Video kreira sažetiju datoteku, što rezultira manjom veličinom datoteke. Ovakva datoteka može biti gledana pomoću Windows  Media Playera jedino ako je SMART Board softver instaliran na računalu na kojem puštate video.

Odaberite karticu Target Files kako biste promijenili lokaciju na svom računalu gdje se snimljene datoteke spremaju.

Otvara centar za pomoć
SMART Board softvera
Skriva sučelje SMART Recordera (snimač je još uvijek dostupan putem ikone koja
se nalazi u notifikacijskom području Windowsa)
SMART Video Player

Koristite SMART Video Player kako biste pisali preko pojedine sličice videosnimke i kako biste pohranili svoje bilješke u Softversku bilježnicu. SMART Video Player možete koristiti kako biste puštali videodatoteke smještene na vašem računalu ili kako biste gledali sadržaj s kamere, videorekordera, CD–ROM–a ili DVD–a. SMART Video Player je kompatibilan s većinom videokamera i kamera za dokumente.

Reprodukcija i upravljanje videodatotekama

Otvorite SMART Video Player u izborniku SMART Board alata. Odaberite File > Open te pronađite videodatoteku na svom računalu. Vaš video bit će reproduciran u prozoru SMART Video Player.
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	Traka napretka: grafički pokazatelj koji pokazuje koliko je vremena preostalo u filmu
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	Boja olovke: promijenite boju olovke

	
	Pokretanje/Pauza: pustite ili pauzirajte film
	
	Debljina linije: promijenite debljinu linije za olovku

	
	Stop: zaustavite film i premotajte ga na početak
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	Čišćenje zaslona: uklonite sve bilješke napisane preko videa
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	Pohrana slike: pohranite trenutačnu sličicu u Softversku bilježnicu
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	Puni zaslon: upotrijebite cijeli zaslon za prikazivanje videa
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	Pokazivač: vratite miša u način rada pokazivača
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	Isključivanje tona: prekida sav zvuk
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	Olovka: Koristite pokazivač kao alat za pisanje
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	Klizač zvuka: pojačava ili smanjuje jačinu zvuka


Pauza tijekom pisanja

Zadana postavka za Video Player je da pauzira snimku svaki put kada se koristi alat olovka. Ako želite da se video nastavi puštati kad god koristite olovku ili brisač, učinite sljedeće:
1 
Odaberite Settings > Video Player Settings.
 
Uklonite kvačicu iz kućice Pause when tool(s)
lifted.
3 
Pritisnite OK.
Nestajanje bilješki

Kako se video reproducira, možda biste htjeli da vaše bilješke nestanu a da ne morate stisnuti gumb za čišćenje zaslona. Kako biste uključili ili isključili opciju nestajanja bilješki, učinite sljedeće:
1 
Odaberite Settings > Video Player Settings
 
Postavite ili uklonite kvačicu iz kućice Fade out
annotations.
3 
Odredite koliko vremena (u sekundama)
treba proći prije nego što digitalna tinta počne nestajati i koliko bi vremena trebalo da se zaslon očisti.
 
Pritisnite OK.
Određivanje veličine  videa

SMART Video Player uključuje tri veličine za gledanje: 100%, 200% i prikaz preko cijelog zaslona. Kako biste odredili veličinu svog videa tijekom reprodukcije, odaberite željenu veličinu iz izbornika View.
Ako odaberete 100% ili 200%, video se reproducira u prozoru koji uključuje traku s nazivom,
traku izbornika, alatnu traku i statusnu traku. S druge strane, prikaz preko cijelog zaslona koristi cijelu interaktivnu ploču ili zaslon, tako da ni izbornik ni alatna traka nisu vidljivi.
Kada odaberete prikaz preko cijelog zaslona, pojavljuje se drukčija alatna traka s gumbima za reproduciranje i pauziranje videa, kao i za pohranu slika zaslona
i brisanje napisanih komentara. Ova alatna traka također uključuje gumb za povratak u normalni prikaz.
Korištenje signala iz videouređaja

Kada spojite videouređaj (kao što su videorekorder ili videokamera) na svoj sustav, SMART Video Player prepoznaje uređaj
te ga dodaje u izbornik Hardware. Odaberite uređaj koji želite koristiti iz izbornika Hardware.

Alatna traka pri punom prikazu
Plutajući alati (Floating Tool)s

Funkcije koje najčešće koristite doslovno su vam na dohvat ruke uz alatnu trake Plutajući alati (Floating Tools).
Kako biste pokrenuli Plutajuće alate (Floating Tools), odaberite ikonu SMART Board u donjem desnom kutu zaslona te odaberite opciju Plutajući alati (Floating Tools) u izborniku SMART Board alata.
	Gumb
	Upotrijebite ovaj gumb kako biste
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	prestali koristiti druge alate i vratili pokazivač u način rada kao mišem

	
	pisali ili crtali u digitalnoj tinti (crno)

	
	pisali ili crtali u digitalnoj tinti (crveno)

	
	označili dio zaslona pomoću prozirne tinte radi naglašavanja

	
	upotrijebili brisalo

	
	odredili sljedeći pritisak na interaktivnoj ploči kao desni klik

	
	pokrenuli SMART Notebook

	
	pokrenuli tipkovnicu

	
	poništili posljednju radnju


	
	  poništili posljednju radnju



Prilagodba alatne trake Floating Tools
Pritisnite gumb Dodatno te iz padajućeg izbornika odaberite Customize Floating Tools kako biste pokrenuli dijaloški okvir za prilagodbu alatne trake Floating Tools.
Dodavanje i uklanjanje alata
Kako biste dodali alat u alatnu traku Floating Tools, učinite sljedeće:
1   Odaberite alat iz popisa dostupnih alata (Available Tools).
    Pritisnite gumb Add >> kako biste odabrani alat dodali u trenutnu alatnu traku (Current Toolbar).
3   Pritisnite OK te će odabrani alat biti dodan u alatnu traku Floating Tools. Kako biste uklonili alat iz alatne trake Floating Tools, učinite sljedeće:
1   Odaberite alat iz popisa alata trenutačne alatne trake (Current Toolbar).
    Pritisnite gumb << Remove i odabrani će alat biti uklonjen iz trenutačne alatne trake (Current
Toolbar).
3   Pritisnite OK i odabrani se alat više ne će pojavljivati u alatnoj traci Floating Tools.
SAVJET: Pritisnite gumb Vrati zadane postavke (Restore Default Toolbar) u donjem lijevom kutu dijaloškog okvira za prilagodbu alatne trake Floating Tools kako biste vratili alatnu traku u klasični ili kreativni set postavki.

 Izravna konferencija
Odaberite opciju Izravna konferencija (Instant Conferencing) u izborniku SMART Board alata kako biste uspostavili instantnu konferenciju pomoću dijaloškog okvira Bridgit™.
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Pritisnite gumb Share SMART Board kako biste putem interneta podijelili radnu površinu svog računala sa sudionicima sastanka ili predavanja. Dijaloški okvir za kreiranje konferencije vodit će vas kroz postupke potrebne za pokretanje konferencije te će vas upitati da pozovete sudionike vaše konferencije.

Pritisnite gumb Join a Conference kako biste pokrenuli dijaloški okvir konferencijskog softvera Bridgit. U polje Server Name upišite internetsku adresu poslužitelja koji udomljuje konferenciju kojoj se želite pridružiti te pritisnite gumb za spajanje kako biste vidjeli popis konferencija dostupnih na odabranom poslužitelju. Osoba koja je pokrenula Bridgit konferenciju trebala bi vam moći dati internetsku adresu poslužitelja.

Pritisnite gumb Configure Conferencing Settings kako biste pregledali ili izmijenili informacije vezane uz ime poslužitelja koji se koristi za udomljavanje konferencije, svoje ime i lozinku za vaš korisnički račun.

Saznajte više o softveru Bridgit preuzimajući brzi vodič s internetske stranice www.smarttech.com/trainingcenter/windows/trainingmaterials.asp.

Prisustvujte besplatnom internetskom treningu o softveru Bridgit. Detalji, datum i vremena za internetske treninge dostupni su na adresi
www.smarttech.com/trainingcenter/windows/trainingmaterials.asp.
Ostali alati

Pokrenite dodatne SMART Board alate pritišćući ikonu SMART Board u donjem desnog kutu  zaslona te potom birajući opciju Other SMART Tools. Neki od dostupnih alata u izborniku Other SMART Tools su: alatna traka za pohranu slike zaslona (Screen Capture), pokazivač (Pointer), sjenilo zaslona (Screen Shade), reflektor (Spotlight) i povećalo (Magnifier).
Alatna traka za pohranu slike zaslona obrađena je u poglavlju SMART Notebook.
Upotrijebite pokazivač kako biste pokrenuli mali pokazivač kojim možete usmjeravati pažnju publike na važne dijelove informacija koje su dostupne na zaslonu.
Sjenčanje zaslona Postupno otkrivajte informacije svojoj publici ili učenicima koristeći sjenilo zaslona.

Pritisnite i držite ručku sjenila zaslona, potom je povucite u smjeru u kojem želite otkriti informacije.

Dvaput pritisnite sjenilo zaslona kako biste ponovno prekrili  zaslon.
Reflektor
Reflektor pomaže usmjeriti pozornost slušatelja na specifični dio vašeg zaslona.
Pritisnite strelicu padajućeg izbornika kako biste pregledali opcije koje će vam omogućiti  promjenu oblika i prozirnosti reflektora. Strelica padajućeg izbornika također se koristi za zatvaranje reflektora.
Raširite ili skupite reflektor tako da pritisnete i vučete plavi graničnik. Premjestite reflektor tako da pritisnete bilo gdje na tamnom području zaslona te ga odvučete
na područje zaslona na koje želite usmjeriti pozornost svoje publike.

Povećalo
Povećalo se sastoji od dva prozora. Koristite manji prozor kako biste odabrali područje zaslona koje želite uvećati, kao što je ćelija proračunske tablice ili
internetska adresa koju ljudi u zadnjim redovima publike teško mogu vidjeti. Veći prozor prikazuje uvećani prikaz područja koje je pod povećalom.
Povucite rub velikog okvira kako biste povećali ili smanjili područje koje će biti pod povećalom.


Ručke sjenila zaslona
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Upravljačka ploča
Nadzorna ploča je mjesto gdje možete prilagoditi raznovrsne softverske i hardverske postavke svog interaktivnog proizvoda tvrtke SMART. Kako biste otvorili nadzornu ploču, pritisnite ikonu SMART Board smještenu u notifikacijskom području Windowsa u donjem desnom kutu zaslona, te odaberite opciju Upravljačka ploča (Control Panel).
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Postavke interaktivne ploče
Prozor Postavke SMART hardvera (SMART Board Settings) omogućava vam provjeru statusa veze s interaktivnom pločom, te  ručno uspostavljanje veze s vašim proizvodom ako je to potrebno. Dijaloški okvir postavki za SMART Board omogućava vam da prilagodite videoizlaz i obavite ostale procedure vezane za hardver.
Orijentiranje / poravnanje interaktivne ploče
Pokrenite proces orijentacije tako da pritisnete gumb Usmjeri/poravnaj SMART proizvod (Orient/Align the SMART Board). Proces orijentacije u ovom udžbeniku detaljno je obrađen u poglavlju Kako započeti.

Čarobnjak za spajanje interaktivne ploče
Gumb Čarobnjak za povezivanje (SMART Board Connection Wizard) omogućava vam brzo spajanje vaše interaktivne ploče s vašim računalom, te omogućava prilagodbu slike koja se projicira na površini interaktivne ploče.
Postavke programa Podaci o tinti

Gumb Postavke programa Podaci o tinti (Ink Aware Application Settings) omogućava promjenu postavki za opažanje tinte. Opažanje tinte integrira SMART Board softver s ostalim aplikacijama, uključujući i popularne alate za prezentacije, obradu teksta i grafičke aplikacije. Uključite ili isključite opažanje tinte za aplikaciju koristeći odgovarajuću kvačicu u popisu aplikacija koje opažaju tintu.
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Jezične postavke SMART Board softvera
Gumb Postavke jezika (SMART Board Software Language Settings) omogućava vam instalaciju bilo kojeg od brojnih jezičnih paketa dostupnih u SMART Board softveru. Jednom kad ste instalirali dodatne jezične pakete, možete promijeniti jezik sučelja SMART Board softvera koristeći padajući izbornik u jezičnim postavkama SMART Board softvera.
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Dodatni izvori
Što je sljedeće?

Tvrtka SMART podržava vaše korištenje naših proizvoda nizom dostupnih izvora, uključujući besplatne materijale za trening na internetskim stranicma tvrtke, posebnu internetsku zajednicu
za prosvjetne radnike, te besplatnu verziju softvera za pojmovne mreže SMART Ideas uz svaku registriranu interaktivnu ploču SMART Board.
Obrazovni centar SMART
Obrazovni centar SMART je mjesto gdje ćete pronaći dodatne izvore za učenje i podršku, uključujući i besplatne materijale i internetske tečajeve. Posjetite www.smarttech.com/trainingcenter.

Besplatni materijali za učenje
Besplatni materijali za učenje dostupni na www.smarttech.com sastoje se od brzih vodiča, praktičnih vježbi i dvominutnih poduka.
Brzi vodiči su jednostavni jednostrani ili dvostrani vodiči koji objašnjavaju funkcije proizvoda tvrtke SMART. Namijenjeni su za ispis kako biste ih mogli držati odmah pored svoje interaktivne ploče SMART Board.

Praktične vježbe izvode aktivnosti korak po korak, pa ih je jednostavno pratiti i pomoću njih ponavljati ono što ste već naučili.
Dvominutne poduke su kratki, animirani uvodi u rad sa SMART Board softverom.
Besplatni internetski tečajevi
Internetski treninzi SMART su tridesetominutne konferencije pomoću računala i telefona, koje pružaju brz, besplatan pregled osnova rada s interaktivnom pločom SMART Board. Svaki trening vodi SMART-ov trener koji koristi proizvode tvrtke SMART svaki dan. Naučit ćete kako koristiti proizvod tvrtke SMART još učinkovitije te ćete imati priliku postavljati pitanja.
Besplatni internetski tečajevi uključuju sljedeće lekcije:
•  osnove interaktivne ploče SMART Board
•  osnove SMART Notebooka

•  postavljanje interaktivne ploče SMART Board
•  osnove softvera SMART Ideas
Uvijek razvijamo nove, besplatne internetske tečajeve. Često posjećujte Obrazovni centar SMART kako biste saznali o najnovijim treninzima.
Web stranica za edukacijska rješenja tvrtke SMART
Web stranica za edukacijska rješenja tvrtke SMART je internetska zajednica gdje prosvjetni radnici mogu dijeliti izvore i ideje s drugim kolegama diljem svijeta. Mrežna stranica za edukacijska rješenja je mjesto gdje ćete pronaći sljedeće izvore:
•  Besplatni materijali za učenje koji se mogu koristiti za proizvode tvrtke SMART, uključujući zbirke sadržaja, softverske aplikacije i internetske resurse
•  Stotine lekcija za Softversku bilježnicu čije su aktivnosti vezane uz državne i regionalne nastavne standarde
•  Profesionalni razvojni programi za nagrađivanje, prepoznavanje i podršku prosvjetnim radnicima

•  Istraživanja o učinkovitosti interaktivne ploče SMART Board u nastavnim okruženjima
•  Savjeti za prosvjetne radnike o uporabi SMART proizvoda i usklađivanju periferije, savjeti za usavršavanje pisanja zahtjeva za financijskom pomoći, te savjeti za procjenu tehnologija
Posjetite education.smarttech.com.
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Što je softver za pojmovne mreže SMART Ideas®?
Vizualno prezentiranje informacija pomaže učenicima da razviju kritičko razmišljanje u učionici. Interaktivne pojmovne mreže omogućavaju učenicima da istraže neku temu dodajući više razina na mreži te odabirući slike kojima će ih ilustrirati. Softver za pojmovne mreže SMART Ideas ne samo da pomaže vašim učenicima spojiti ideje, organizirati koncepte i planirati projekte nego ih motivira i da uče.
Registrirani korisnici interaktivne ploče SMART Board dobivaju besplatnu verziju softvera SMART
Ideas. Posjetite internetsku stranicu tvrtke SMART na adresi  www.smarttech.com, odaberite registraciju proizvoda iz brzih poveznica te obavite proces registracije.
Što je pojmovna mreža?
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Kreiranje znakova pomoću softvera SMART Ideas
Otvorite softver SMART Ideas i odaberite prazan dijagram.
1 
Napišite Heavy rain (jaka kiša).
 
Pritisnite Enter.
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3 
Kreirajte drugi znak tako da natipkate Flooding (poplavljivanje).
 
Pritisnite Enter.
Povezivanje znakova pomoću spojnica
Odaberite znak koji biste htjeli povezati s drugim znakom.
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1. Odaberite ikonu spojnice

2. Povucite je na
simbol koji želite povezati

3. Spojnica će povezati simbole
Ili nacrtajte liniju kako biste povezali svoje znakove.
1. Odaberite simbole koje želite povezati

2. Nacrtajte liniju od jednog simbola prema drugome

3. Spojnica će povezati simbole
Imenovanje spojnica
Imenujte spojnicu kako biste pokazali kako su ideje povezane jedna s drugom.
1 
Izaberite ikonu spojnice i pritisnite unutar okvira.
 
Upišite naziv svoje spojnice.
3 
Pritisnite Enter.
Proširivanje i skupljanje stabla dijagrama
Odaberite znak koji je povezan s drugim znakom. Spojnica može biti raširena ili skupljena.
Pritisnite ovdje kako biste skupili svoje stablo dijagrama

Pritisnite ovdje kako biste raširili svoje stablo dijagrama
Rašireno

Skupljeno
Skupljeno

Rašireno
Kreiranje slojevitih dijagrama
Možete kreirati neograničen broj podrazina unutar svog dijagrama, koje mogu biti upotrijebljene kako biste pružili više informacija o specifičnim idejama. Svaka podrazina sadrži novi dijagram i dio je vaše izvorne SMART Ideas datoteke.
Kreiranje nove razine
1 
Pritisnite zelenu strelicu u gornjem lijevom kutu odabranog znaka.
 
Otvorit će se novi prazan radni prostor. Kreirajte svoj dijagram podrazine.
3 
Kada radite u podrazini, koristite se poveznicama koje se pojavljuju u gornjem lijevom kutu vašeg radnog područja kako biste se vratili natrag na glavni dijagram.
Pritisnite zelenu strelicu na znaku kako biste se vratili na podrazinu dijagrama.
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